




Microsoft

Word 2013 Plain & Simple

Jay Freedman



Copyright © 2013 by Joseph J. Freedman

All rights reserved. No part of the contents of this book may be reproduced or transmitted in any form or by any means without 
the written permission of the publisher.

ISBN: 978-0-7356-6938-3

1 2 3 4 5 6 7 8 9  QG  8 7 6 5 4 3

Printed and bound in the United States of America.

Microsoft Press books are available through booksellers and distributors worldwide. If you need support related to this book, 
email Microsoft Press Book Support at mspinput@microsoft.com. Please tell us what you think of this book at http://www.
microsoft.com/learning/booksurvey. 

Microsoft and the trademarks listed at http://www.microsoft.com/about/legal/en/us/IntellectualProperty/Trademarks/EN-US.
aspx are trademarks of the Microsoft group of companies.  All other marks are property of their respective owners.

The example companies, organizations, products, domain names, email addresses, logos, people, places, and events depicted 
herein are fictitious. No association with any real company, organization, product, domain name, email address, logo, person, 
place, or event is intended or should be inferred.

This book expresses the author’s views and opinions. The information contained in this book is provided without any express, 
statutory, or implied warranties. Neither the authors, Microsoft Corporation, nor its resellers, or distributors 
will be held liable for any damages caused or alleged to be caused either directly or indirectly by this book.

Acquisitions Editor: Kenyon Brown
Developmental Editor: Kathryn Duggan
Production Editor: Kristen Borg
Editorial Production: Peter Amirault
Technical Reviewer: Kristen Merritt
Copyeditor: Bob Russell
Indexers: Fred Brown and Bob Pfahler
Cover Design: Twist Creative • Seattle 
Cover Composition: Zyg Group, LLC
Illustrator: S4Carlisle Publishing Services



To Andi, my bashert.





Contents  v

Contents
Acknowledgments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    xv

1 About this book. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 1

What do you want to do?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              2

A quick overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     3

A few assumptions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    6

Adapting task procedures for touchscreens. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               7

A final word. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                          8

2 Introducing Word 2013. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 9

What’s new in Word 2013. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             10

Starting the Word program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           12

Exploring the ribbon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 14

Using the Quick Access Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        16

Switching views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      17

Using built-in keyboard shortcuts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      18

Opening documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 20

Editing a PDF document. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              22

Getting information about a document. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 23

Saving documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   24



vi  Contents

Exporting a document to other file types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               26

Recovering lost work. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 28

Using the Read Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                30

Managing your online accounts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        32

Printing a document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 34

Finding help in Word. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 36

Finding help on the Internet. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           37

3 Creating and revising documents . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 39

Starting a new document. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             40

Selecting text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .42

Inserting and overtyping text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         44

Copying and moving Items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            45

Managing the Office clipboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        48

Undoing mistaken actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49

Navigating a document in the Navigation pane. . . . . . . . . . . . . . . . . . . . . . . . . .                          50

Navigating by using the search feature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 51

Replacing existing text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                54

Using wildcard find and replace. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        56

Organizing topics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    59

Inserting built-in building blocks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       61

Creating your own building blocks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     62

Managing building blocks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64



Contents  vii

4 Correcting and improving the text . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 67

Correcting a spelling or grammar error. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 68

Running a manual spelling or grammar check . . . . . . . . . . . . . . . . . . . . . . . . . . .                           70

Marking text to ignore spelling. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        71

Adding common misspellings to AutoCorrect. . . . . . . . . . . . . . . . . . . . . . . . . . . .                            72

Using AutoCorrect entries as shortcuts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  74

Setting AutoFormat options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           76

Getting definitions and synonyms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      79

Counting words. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .82

Finding a translation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 83

Changing the proofing language of text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                86

5 Formatting text for best appearance. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 89

Formatting with styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                90

Creating and modifying styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         94

Using the Styles pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               100

Changing the character formatting of text . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             103

Applying highlighting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              105

Using the Format Painter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Changing paragraph alignment and indents. . . . . . . . . . . . . . . . . . . . . . . . . . . .                            107

Changing line and paragraph spacing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 110

Controlling line and page breaks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     113

Adding borders and shading. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         116

Building a bulleted or numbered list. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  120

Changing the bullets or numbering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  121



viii  Contents

Changing numbering values. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         126

Using multilevel numbered headings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 128

Revealing existing formatting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        132

6 Building impressive documents. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 135

Inserting a section break. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            136

Inserting headers and footers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       138

Choosing page size and margins. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     140

Changing the page orientation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      144

Changing the number of columns. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    148

Applying a border around a page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     151

Inserting a cover page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              154

Working with the Normal template. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156

Finding and downloading templates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   159

Customizing an existing template. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     161

Designing a template. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                165

Basing a new document on a custom template . . . . . . . . . . . . . . . . . . . . . . . . .                        168

Designing a template for two-sided printing . . . . . . . . . . . . . . . . . . . . . . . . . . .                           170

Using themes and style sets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          173

7 Making layouts with tables and text boxes. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 179

Inserting tab stops on the ruler. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      180

Inserting a simple table. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              181

Copying an Excel table into Word. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    183

Converting text to a table and back again. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             184



Contents  ix

Setting tab atops in table cells. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       186

Adding and deleting rows and columns. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               187

Resizing rows and columns. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          188

Setting table alignment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             189

Setting table text wrapping. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         190

Merging and splitting cells. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           191

Setting cell alignment and direction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   192

Repeating header rows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              193

Using table styles for uniform appearance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             194

Inserting text boxes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                196

Linking a chain of text boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        198

8 Managing data in documents. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 199

Using the Field dialog box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          200

Inserting fields from the keyboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   202

Toggling field codes and updating fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              203

Controlling field formatting by using switches. . . . . . . . . . . . . . . . . . . . . . . . . .                         205

Inserting Page and Date fields by using shortcuts. . . . . . . . . . . . . . . . . . . . . . .                       210

Using bookmarks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   211

Inserting hyperlinks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                212

Repeating information by using cross-references. . . . . . . . . . . . . . . . . . . . . . . .                        216

Inserting content controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            217

Grouping content controls for a form. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 222

Using document properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         223

Sorting a list. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225



x  Contents

9 Formatting reports and formal documents. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 227

Making a different first page header or different odd  
and even pages header. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             228

Unlinking a header. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  232

Extracting text for a header or footer from body text. . . . . . . . . . . . . . . . . . . .                   234

Inserting a watermark. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               237

Adding footnotes and endnotes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      241

Generating a table of contents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        243

Updating a table of contents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        248

Modifying table of contents styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    249

Using multiple tables of contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     252

Indexing a document. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                255

Using multiple indexes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              258

Making tables of tables and tables of figures. . . . . . . . . . . . . . . . . . . . . . . . . . .                          262

Creating a bibliography. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             264

10 Making pictures work for you. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 269

Choosing illustration types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           270

Inserting a picture from your computer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                274

Inserting an online picture. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           276

Inserting online video. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               278

Inserting a screenshot. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              280

Positioning pictures on the page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     282

Resizing a picture. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  284

Cropping a picture. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 286



Contents  xi

Replacing a picture. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 288

Changing the appearance of a picture. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                290

Removing the background from a picture. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             293

Applying special effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             295

Setting a transparent color. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          296

11 Adding your own artwork. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 297

Inserting a shape . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  298

Changing the appearance of a shape. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 300

Building charts to display data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       304

Creating SmartArt diagrams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         308

Adding WordArt effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             312

12 Mailing paper or pixels . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 315

Printing a single envelope. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            316

Printing multiple copies of an envelope. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               320

Changing envelope address formatting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                323

Creating mailing labels and business cards. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             326

Sending a document by email. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        332

Starting a mail merge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              334

Choosing the recipients. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              337

Adding merge fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 341

Adding information with rules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       343

Finishing the merge. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                346



xii  Contents

13 Reviewing documents. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 349

Adding comments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  350

Showing and hiding comments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       352

Tracking changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   353

Showing and hiding tracked changes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 354

Setting options for Track Changes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     356

Accepting and rejecting changes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      358

Comparing reviewed versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        359

Merging reviewed versions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           361

14 Sharing and coauthoring in Word. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 363

Exploring Word Web App. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           364

Sharing with SkyDrive. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               370

Working with coauthors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             372

Talking to your coauthors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            374

Blogging with Word. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 375

Presenting a document online. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        378

15 Ensuring privacy and security . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 381

Viewing the Word 2013 Trust Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 382

Changing which files open in Protected View. . . . . . . . . . . . . . . . . . . . . . . . . . .                          383

Adding trusted locations and trusted publishers . . . . . . . . . . . . . . . . . . . . . . . .                       387

Setting privacy options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             390

Using the Document Inspector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       392

Protecting a document by using a password. . . . . . . . . . . . . . . . . . . . . . . . . . . .                           394



Contents  xiii

Restricting editing and formatting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    397

Marking a document as read-only or final. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             400

Adding a digital signature. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           403

16 Installing and using Apps for Office . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  405

Adding an app from the Office Store. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 406

Using an app in a document. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          410

17 Customizing Word. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 413

Customizing the screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              414

Customizing the keyboard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           417

Customizing the Quick Access Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 421

Creating a custom tab or group on the ribbon. . . . . . . . . . . . . . . . . . . . . . . . . .                          423

Adding tools to a custom group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      426

Setting general options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              428

Controlling what is displayed and printed. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              429

Setting spelling and grammar options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                430

Changing the default file format for saving documents . . . . . . . . . . . . . . . . . .                 434

Working with advanced options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      436

Managing styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   442

Recording macros. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  444

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             447 
 
About the author. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   457





Acknowledgments  xv

Acknowledgments
Every book is the product of many hands, and I thank each 
person who has helped to create this one. Even if I don’t know 
your name, please know that I’m grateful for your efforts.

Special thanks go to Senior Editor Kenyon Brown of O’Reilly 
Media for asking me to write Microsoft Word 2013 Plain & 
Simple. His early guidance and encouragement were invaluable.

Developmental Editor Kathi Duggan made hundreds of excel-
lent suggestions that greatly improved the logical flow of the 
manuscript, and Technical Reviewer Kristen Merritt played an 
important role in keeping me on the right path. The three of us 
make quite a team!

Thanks to Senior Production Editor Kristen Borg and copyeditor Bob 
Russell, who polished my language and helped me to adhere to 
Microsoft Press standards. We’ve given Word’s Track Changes 
feature a good workout!

I’ve answered thousands of questions about Microsoft Word 
over nearly twenty years in Internet newsgroups and forums. To 
every one of you who asked those questions, thank you for the 
inspiration to learn about the mysteries of Word. I also thank all 
of the Microsoft Office development team members with whom 
I’ve had many fruitful discussions, especially Stuart Stuple, 
Tristan Davis, and Jonathan Bailor.

Most of all, I thank my wife, Andi Freedman, who thought I had 
retired months ago. Soon…



Mailing paper  
or pixels

One of the most common uses of Microsoft Word 2013 is the creation 
of documents that are to be sent to other people. The documents 

might be printed on paper and mailed in an envelope, or they might be 
attached to an email message. They can be generated one at a time or 
built in large numbers from information in a worksheet or a database.

The mail merge feature in Word 2013 has many more uses than just mail-
ing letters. Any task that involves a standard format that you want to pop-
ulate with many pieces of information is a candidate for a merge. Think of 
name labels for a meeting, certificates for completing a course, a catalog 
of items for sale, or a voter registration list—any of these could be created 
with an appropriate mail merge.

In this section:

■■ Printing a single envelope

■■ Printing multiple copies of an envelope

■■ Changing envelope address formatting

■■ Creating mailing labels and business 
cards

■■ Sending a document by email

■■ Starting a mail merge

■■ Choosing the recipients

■■ Adding merge fields

■■ Adding information with rules

■■ Finishing the merge

12



Address an envelope and print
1	 If you’re addressing a letter that contains the recipient’s address, 

open the letter document. Otherwise, open any document (such as 
the default blank document).

If you create an envelope while the cursor is in a letter document, 
and if the document starts with up to four single-line paragraphs 
that are left-aligned, those paragraphs will automatically appear 
as the delivery address in the Envelope dialog box. If you want to 
determine which paragraphs will appear in the Envelope dialog box, 
select those paragraphs in the letter document before you launch 
the dialog box.

2	 On the Mailings tab, in the Create group, click Envelopes.

Printing a single envelope
If you’re addressing a letter, a greeting card, or other one-time 
item, you might want to print the envelope but not save it for 
future use. Word 2013 includes predefined layouts for many 

common envelope sizes, and you can define a custom size if 
necessary.

2

1
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3	 In the Envelopes And Labels dialog box, if the Delivery Address box 
is empty, or if the text is incomplete or incorrect, add or edit the 
text as needed.

4	 If the Return Address box is empty, or if the text is incomplete or 
incorrect, add or edit the text as needed. If you don’t want a return 
address to print on the envelope, select the Omit check box.

5	 If the envelope size shown in the Preview thumbnail is incorrect, 
or if the orientation shown in the Feed thumbnail is incorrect, see 
“Change envelope size and print options” on page 318.

6	 Click the Print button.

3

4

6

5

TIP  To use the electronic postage option, you must first install 
an electronic postage program and subscribe to a service.

TRY THIS  If you have an address book in Microsoft Outlook 
and it contains information for the envelope’s recipient, you can 

click the Address Book icon above the Delivery Address box and select 
the recipient’s name. The mailing address will be transferred from the 
address book entry to the Delivery Address box. You can also use the 
Address Book icon above the Return Address box to enter a return 
address from your address book.

Printing a single envelope: Address an envelope and print  317

12: Mailing paper or pixels 



Change envelope size and print options
1	 On the Mailings tab, in the Create group, click Envelopes.

2	 If you want to change the size of the envelope or the feed orienta-
tion, click the Options button.

3	 On the Envelope Options tab in the Envelope Options dialog box, 
click the Envelope Size box and click the desired size in the drop-
down list.

If none of the listed sizes match the envelope that you want to 
print, click Custom Size at the bottom of the list and enter the cor-
rect measurements.

4	 If you want to change the font formatting of the delivery address, 
in the Delivery Address section in the Envelope Options dialog box, 
click the Font button, select the formatting in the Envelope Address 
dialog box, and then click OK. If you want to change the distance of 
the delivery address from the left and top edges of the envelope, in 
the From Left and From Top boxes enter the desired measurements.

If you want to change the same settings for the return address, 
use the Font button and the From Left and From Top boxes in the 
Return Address section of the Envelope Options dialog box.

2

1

3
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5	 If you want to change the feed orientation, on the Printing Options 
tab, click the icon that matches the direction of your printer’s 
envelope feed and the position of the envelope in the feed tray. 
If necessary, select whether the envelopes are placed in the feed 
tray with the printing side up or down, and which tray contains 
envelopes.

6	 Click OK. 5

6

SEE ALSO  For more information about changing the format-
ting of the delivery address, see “Add direct formatting to one 

address” on page 323 and “Modify the Envelope Address style” on page 
324.

Printing a single envelope: Change envelope size and print options  319

12: Mailing paper or pixels 



Add an envelope to a document
1	 If you’re addressing a letter that contains the recipient’s address, 

open the letter document. Otherwise, open any document (such as 
the default blank document).

2	 On the Mailings tab, in the Create group, click Envelopes.

Printing multiple copies of an envelope
You might need to print several copies of the same envelope at 
one time, for instance as self-addressed envelopes to include 
with items to be returned to you. The Print button in the Enve-
lopes And Labels dialog box can print only one copy at a time, 
so you need a different approach.

In Word 2013, you can add the envelope to the current docu-
ment and save it as part of the document’s file. The envelope 
appears as page 0 in a new Section 1 at the beginning of the 
document, formatted with the page size and margins appro-
priate for the envelope. Then, you can use the Print command 
in the Backstage view, which offers a setting for the number of 
copies to print.

2

1
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3	 If the Delivery Address text box is empty, or if the text is incomplete 
or incorrect, edit the text as needed.

4	 If the Return Address text box is empty, or if the text is incomplete 
or incorrect, edit the text as needed. If you don’t want a return 
address to print on the envelope, select the Omit check box.

5	 If the envelope size shown in the Preview thumbnail is incorrect, 
or if the orientation shown in the Feed thumbnail is incorrect, see 
“Change envelope size and print options” on page 318.

6	 Click the Add To Document button.

6

3

4 5

Printing multiple copies of an envelope: Add an envelope to a document  321

12: Mailing paper or pixels 



Print the envelope
1	 Click in the envelope page in the document, and then click File to 

display the Backstage view.

2	 Click the Print tab.

3	 In the Settings section, click the first box and click Print Current 
Page.

4	 If the selected printer is not the one on which you want to print the 
envelope, click the Printer box and select the correct printer.

5	 Click the Copies box and enter the desired number of copies of the 
envelope.

6	 Click the Print button.

1

6

2

3

54

TIP  If you save the document that includes the envelope, you 
can print the envelope again at any time.
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Add direct formatting to one address
1	 Open the document for which you want to create an envelope.

2	 On the Mailings tab, in the Create group, click Envelopes.

3	 If the Delivery Address text box in the Envelopes And Labels dialog 
box is empty, or if the text is incomplete or incorrect, add or edit 
the text as needed.

4	 Select the part of the address for which you want to change the 
formatting.

5	 Right-click the selected text and then, on the shortcut menu that 
appears, click Font.

6	 In the Font dialog box, change the font name, font size, bold, italic, 
color, or other formats as desired, and then click OK.

7	 Click the Print button.

Changing envelope address formatting
If you want to change the formatting of the address on an enve-
lope that you’ll print only once, you can apply direct character 
formatting to it. If you want to change the formatting for all 

future envelopes, you’ll save time and effort by modifying the 
address styles in the Normal.dotm template.

2

1

3

5

7
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Modify the Envelope Address style
1	 On the Home tab, in the Styles group, click the dialog box launcher 

(shortcut, Ctrl+Alt+Shift+S).

2	 In the Styles pane, if the Envelope Address style and the Envelope 
Return styles are listed, continue with step 4. If the two styles are 
not listed, click the Options link at the bottom of the pane and 
continue with step 3.

3	 In the Style Pane Options dialog box, click the Select Styles To Show 
list box, select All Styles, and then click OK.

4	 In the Styles pane, right-click the name of the Envelope Address 
style and then, on the shortcut menu that appears, click Modify.

1

2

3

4

324  Changing envelope address formatting: Modify the Envelope Address style

12: Mailing paper or pixels 



5	 In the Modify Style dialog box, click the New Documents Based 
On This Template option. Then, select the font and paragraph 
formatting you want for the delivery address in all new envelopes. 
For more information about changing the definition of a style, see 
“Modify an existing style by using a dialog box” on page 95.

6	 The definition of the Envelope Address style includes a borderless 
frame with a fixed size that positions the text on the envelope 
page. If the frame is too small to hold your typical addresses, at the 
bottom of the Modify Style dialog box, click the Format button and 
then, on the shortcut menu that appears, click Frame. In the Frame 
dialog box, change the Width and Height list boxes from Exactly to 
Auto.

6
SEE ALSO  For more information about modifying the 
Envelope Address and Envelope Return styles, see www.gmayor.

com/changing_envelope_layout.htm and www.gmayor.com/alternative_
return_addresses.htm.

TIP  You can repeat steps 4 and 5 to modify the Envelope 
Return style to change the formatting of the return address in 

all new envelopes. The Envelope Return style does not include a frame.

5
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Print one label or a full page of labels
1	 If you’re creating a mailing label for a letter that contains the 

recipient’s address, open the letter document. Otherwise, open any 
document (such as the default blank document).

2	 On the Mailings tab, in the Create group, click Labels.

3	 In the Envelopes And Labels dialog box, if the Address box is empty, 
or if the text is incomplete or incorrect, add or edit the text as 
needed.

4	 If the product name and number shown in the Label section of the 
dialog box match the label paper in the printer, skip to step 9. Oth-
erwise, at the bottom of the dialog box, click the Options button 
and continue at step 5.

Creating mailing labels and business cards
Printed labels are useful for such things as mailing packages, 
creating personalized book plates, and labeling the wires 
plugged into the back of your computer. Stationers sell label 
paper in hundreds of sizes, colors, and shapes.

You can print business cards on perforated card paper, which 
is available from the same sources that sell label sheets. Word 

2013 uses the same feature to create both labels and business 
cards—the only difference is your selection of the format to use.

If you don’t want to create your own design, you can download 
label templates from Office.com and other online sources. For 
information about downloading templates, see “Get templates 
from Office.com” on page 159.

2

1
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5	 Click the option button that describes the type of printer attached 
to your computer. (Laser printers and most inkjet printers are page 
printers; dot-matrix printers are usually continuous-feed printers.) 
If the printer has more than one input tray, select the one that con-
tains the label paper.

6	 If the Label Vendors list box doesn’t display the manufacturer of the 
label paper that you’re using, click the box and select the correct 
vendor.

7	 If the item selected in the Product Number list box doesn’t match 
the label paper’s description, select the correct item.

8	 Click OK.

9	 In the Print section of the Envelopes And Labels dialog box, click 
either the Full Page Of The Same Label option or the Single Label 
option, as needed.

If you select Single Label, you can specify the row and column in 
which to print the address. This is useful if you’re printing on a sheet 
of label paper that is already partially used.

10	Click the Print button.

TIP  The entries in the Product Number list box are in alpha-
betical order, not numeric order. That is, all the entries that 

begin with the digit 1 precede the first entry that begins with the digit 
2, regardless of how many digits are in each number.

8

5
6

7

10

9
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Print a page of business cards
1	 On the Mailings tab, in the Create group, click Labels.

2	 In the Envelopes And Labels dialog box, if text appears in the 
Address box, delete it.

3	 If the product name and number shown in the Label section of 
the dialog box match the card stock in the printer, skip to step 8. 
Otherwise, click the Options button and continue at step 4.

4	 Click the option button that describes the type of printer attached 
to your computer. (Laser printers and most inkjet printers are page 
printers; dot-matrix printers are usually continuous-feed printers.) 
If the printer has more than one input tray, select the one that con-
tains the card stock.

5	 If the Label Vendors list box doesn’t describe the manufacturer of 
the card stock that you’re using, click the box and select the correct 
vendor.

6	 If the item selected in the Product Number list box doesn’t match 
the description of the card stock, select the correct item.

7	 Click OK.

3
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8	 In the Envelopes And Labels dialog box, click the option button for 
Full Page Of The Same Label, and then click New Document.

9	 The new document contains a table in which each cell’s height 
and width match those of the cards in the selected card stock. The 
table’s borders are set not to print. If you don’t see the table cells, 
on the Table Tools | Layout contextual tab, in the Table group, click 
View Gridlines.

10	In the upper-left cell of the table, insert the text and graphics that 
you want on your business card.

11	Select the entire upper-left cell of the table and copy it to the clip-
board (shortcut, Ctrl+C).

It’s helpful to display nonprinting characters by clicking the Show/
Hide ¶ button in the Paragraph group on the Home tab. This way, 
you can see and select everything in the cell, including the cell 
marker (¤).

8

9

10

11
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12	Click the table handle in the left margin to select the entire table. 
Then, paste the contents of the clipboard (shortcut, Ctrl+V).

13	Click the File tab to display the Backstage view. Click the Print tab 
and then click the Print button.

13

TIP  Microsoft Publisher is another good choice for creating 
great-looking business cards.

12
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Print a page of different labels
1	 In the procedure “Print one label or a full page of labels” on page 

326, perform steps 1 through 8. In the Envelopes And Labels dialog 
box, click the option button for Full Page Of The Same Label and 
then click New Document. Continue with step 2 below.

2	 In the table cell that corresponds to each label, type or paste the 
information for that label.

3	 Click the File tab to display the Backstage view, click the Print tab, 
and then click the Print button.

1

2

SEE ALSO  If you already have the information for the labels 
stored in a Word table, a Microsoft Excel worksheet, a Microsoft 

Access database, or an Outlook contact list, a mail merge is an 
alternative way to print mailing labels. For information about using a 
mail merge, see “Starting a mail merge” on page 334.

3
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Send a document as an attachment
1	 Open a document that you want to send to another person.

2	 Click File to display the Backstage view and then click the Share tab.

3	 Click Email.

4	 To send the document as an editable Word file, click Send As 
Attachment. If you prefer to send a PDF file or an XPS file, instead, 
click Send As PDF or Send As XPS.

Sending a document by email
You can share your documents with other Word users in several 
ways, and one of those ways is to send a copy of a document 
file by email. If you have an email program on your computer, 

you can send an open Word 2013 document as an attachment 
to a message directly from the Backstage view. You can send 
the document as an editable Word file, a PDF file, or an XPS file.

1

TIP  The entries in the middle pane for Get A Sharing Link and 
Post To Social Networks appear only if the document file is 

stored on SkyDrive or a SharePoint server. In the pane on the right, the 
Send A Link button is available only if the document file is stored on 
SkyDrive or a SharePoint server.

4

2

3
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5	 In the email program’s window, type the recipient’s address, the 
subject, and the body of the message, and then click the Send 
button.

SEE ALSO  For more information about sharing documents in 
Word 2013, see “Sharing with SkyDrive” on page 370.

CAUTION  To be able to send a document as an email 
attachment, a default email program must be configured on 

your computer. If your edition of Office doesn’t include Outlook, you 
can use a third-party program. If your computer runs Windows 8, you 
might be able to use the Microsoft Mail app. If the only available mail 
service is a web mail interface, save the document to a local disk drive 
and then use the web mail program’s command to attach the file to a 
message.

5
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Create the main document
1	 Click File to display the Backstage view. Click the New tab and then 

click Blank Document or a custom template.

Starting a mail merge
In Word 2013, a mail merge starts with a main document, which 
contains the formatting that you want in the final output. It 
might also contain text that you want to appear in each output 
document. You insert merge fields in the main document to 
reserve places for the variable data. You select a document or a 
database as the data source for the merge, and you can select 
which of the recipients listed in the data source will be used to 
create output. If you want, you can preview the output. Finally, 
you can send the output to a file, to the printer, or to an email 
program.

The mail merge feature in Word 2013 is quite flexible; you can 
use any of several kinds of data sources, you can sort and select 

the names or other items that you want to include, and you can 
create the output in several formats. However, this flexibility 
comes at the cost of some complexity. Completing a mail merge 
requires a sequence of steps, as described on the following 
pages.

The commands on the Mailings tab use the term recipients to 
refer to the names of people in a mailing list. You can also use 
Word’s mail merge feature to work with other kinds of lists, such 
as product catalogs, in which case the term recipients refers to 
the items in the list.

1
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2	 If you want to create a letter or an email message to send to multi-
ple addresses, use the new document to write the body of the letter 
or message (that is, everything that will be the same in all of the 
letters).

If you’re creating labels, envelopes, or a directory merge (called a 
catalog merge in some earlier versions of Word), leave the docu-
ment blank.

3	 When the main document is complete, on the Quick Access Toolbar, 
click the Save button. Then, while the document remains open, 
continue at “Select the merge type,” which follows this task.

3 2

Select the merge type
1	 On the Mailings tab, in the Start Mail Merge group, click Start Mail 

Merge. On the drop-down list that appears, click one of the follow-
ing commands:

•	 Letters  Creates an output document containing a separate 
section for each recipient, with each section starting on a new 
page

•	 E-Mail Messages  Creates an email message to each recipient

•	 Envelopes  Creates an output document containing an enve-
lope for each recipient

•	 Labels  Creates an output document containing labels, with 
one label for each recipient

•	 Directory  Creates an output document in which each recipi-
ent’s data starts a new paragraph

1
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2	 If you clicked Labels in step 1, the Label Options dialog box opens 
automatically. Select the printer tray, label vendor, and product 
number, and then click OK. While the document remains open, 
continue at “Choosing the recipients” on page 337.

3	 If you clicked Envelopes in step 1, the Envelope Options dialog box 
opens automatically. Select the envelope size, choose the printing 
options, and then click OK. While the document remains open, 
continue at “Choosing the recipients.”

2

3

TIP  If you prefer the software to guide you through the same 
procedures described in this book, click the Step-By-Step Mail 

Merge Wizard command at the bottom of the Start Mail Merge gallery. 
The wizard leads you through each step.
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Select a data source
1	 On the Mailings tab, in the Start Mail Merge group, click Select 

Recipients. On the menu that appears, click one of the following 
commands:

•	 Type A New List  Opens the New Address List dialog box, in 
which you can type entries for a list and then save them as a 
database (.mdb) file

•	 Use An Existing List  Opens the Select Data Source dialog box, 
in which you can select an existing file (a Word or plain text doc-
ument, an Excel worksheet, or an Access or SQL Server database) 
containing the entries

•	 Choose From Outlook Contacts  Opens the Select Contacts 
dialog box, in which you can select which contact folder to use, 
if your Office edition includes Outlook

2	 If you clicked Type A New List in step 1, in the New Address List 
dialog box, type the names, addresses, and other information. To 
add each entry after the first one, click New Entry. When the list is 
complete, click OK and continue at step 3.

Choosing the recipients
When you create a mail merge in Word 2013, you must choose 
the information that Word puts into the output document. The 
information could be stored in one of a number of places—as a 
table in a Word document, in an Excel worksheet, in an Access 
or Microsoft SQL Server database, or in an Outlook contact list.

After you select the file or other source of the data, Word 
provides tools with which you can refine the list of recipients or 
other records, to sort them on one or more fields, and to edit 
the list entries if necessary.

1

2

TIP  Click the Customize Columns button to add, remove, 
rename, or reorder columns in the New Address List dialog box. 

To sort the entries on any column, click the header of that column.
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3	 In the Save Address List dialog box that automatically opens, 
enter a file name and click Save. Then, continue at “Edit the list of 
recipients” on page 339.

4	 If you clicked Use An Existing List in step 1, the Select Data Source 
dialog box initially displays the contents of the My Data Sources 
folder in your user profile. If the data source that you want to use 
is a Word or plain text document, an Excel worksheet, or an Access 
(.mdb or .accdb) database, navigate to the correct folder and select 
the file containing the data. Then, click Open and continue at “Edit 
the list of recipients.”

5	 If you clicked Choose From Outlook Contacts in step 1, click the 
contact folder that contains the data that you want to use and click 
OK. Then, continue at “Edit the list of recipients.”

3

4

TIP  The two default items in the My Data Sources folder 
launch the Data Connection Wizard, which can help you attach 

the mail merge document to an Access or SQL Server database.

5
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Edit the list of recipients
1	 If you chose an Outlook contacts folder as your data source, the 

Mail Merge Recipients dialog box opens automatically. Otherwise, 
on the Mailings tab, in the Start Mail Merge group, click Edit Recipi-
ent List to open the Mail Merge Recipients dialog box.

2	 Clear the check boxes next to entries that you do not want to 
include in the mail merge; select the check boxes for those that you 
do want to include.

Selecting or clearing the check box in the header row of the list 
causes all of the entries to become selected or cleared, respectively. 
If you want to keep only a few entries selected, first clear the entire 
list and then select those that you want.

3	 If you want to add or delete entries in the list of recipients, click the 
name of the source file in the Data Source box and click Edit. The 
Edit Data Source dialog box that appears is the same as the New 
Address List dialog box shown in step 2 of “Select a data source” on 
page 337.

If the data source is an Outlook contact list, the Edit button does 
not become available. To edit entries in a contact list, you must use 
Outlook’s contact editor.

3

2

1
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4	 The order in which the merge’s results appear is determined by 
the order of the entries in the list of recipients. If you want to sort 
the list of recipients on a single column, click that column’s header. 
To sort on two or three columns, click the Sort link in the Refine 
Recipient List section to open the Filter And Sort dialog box. On the 
Sort tab, in each drop-down list, select the name of the column on 
which to sort, and whether to sort it in ascending or descending 
order.

For example, you can sort the recipients by state, then by last name, 
and finally by first name. In the merge’s results, someone named 
Smith who lives in Arizona would be listed before someone named 
Jones who lives in Wyoming.

5	 If you want to include in the merge only the entries that satisfy cer-
tain criteria, click the Filter link in the Refine Recipient List section 
to open the Filter And Sort dialog box. On the Filter tab, select the 
name of a column in the Field drop-down list, select a condition in 
the Comparison drop-down list, and if necessary enter a value in 
the Compare To list box. You can continue adding criteria, con-
nected by And or Or, as needed to specify the set of recipients to 
include.

For example, to limit the list of recipients to those whose last names 
start with the letter M, select the criteria Last | Greater than or 
equal to | M | And | Last | Less than | N.

6	 When the list of recipients is complete and correctly sorted, click 
OK.

4 6

5
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Insert merge fields in the document
1	 Click in the main document at the location where you want infor-

mation from the data source to be inserted during the merge.

2	 On the Mailings tab, in the Write & Insert Fields group, click the 
drop-down arrow on the Insert Merge Field button and then, in the 
list that appears, click the name of a column from the data source. 
Repeat steps 1 and 2 until the main document contains all the nec-
essary merge fields.

If you selected a label merge, insert merge fields and other text 
only in the upper-left cell of the table in the main document. 
During this step, the other cells contain only a «Next Record» 
merge field. The other cells will be filled in step 4 of this procedure.

If you place another merge field on the same line as the first merge 
field, type a space, text, or punctuation between them as necessary. 
Otherwise, there won’t be any separation between the values in the 
output. If you want the next merge field to appear on the next line, 
press Enter at the end of the first line.

Adding merge fields
For a mail merge to place values from the data source into the 
output, you must insert one or more merge fields into the main 
document. During the merge, each merge field is replaced 
by the corresponding value in the data source for the current 
recipient. For example, suppose a recipient’s record in the data 
source contains the values First_Name = John and Last_Name = 
Clarkson. In the main document for a letter merge, a line might 
contain the merge fields «First_Name» «Last_Name». When 

the record is processed during the merge, those fields will be 
replaced with the text John Clarkson.

You can insert copies of the same merge field into the main 
document in multiple places. For example, the merge field 
«First_Name» could be used in the address, in the greeting line, 
and in the body of the letter.

1 2
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3	 If you want, apply character formatting to some of the merge fields 
in the main document, either directly or by using a character style.

You can right-click a merge field in the main document and click 
Toggle Field Codes to display the complete field code. Then, you 
can insert formatting switches to control the appearance of the 
results in the output. For information about inserting formatting 
switches, see “Controlling field formatting by using switches” on 
page 205.

4	 If you selected a label merge, on the Mailings tab, in the Write & 
Insert Fields group, click Update Labels. This copies the merge fields 
and text that you entered in the upper-left cell of the table into all 
the other cells.

3

4

TRY THIS  On the Mailings tab, in the Write & Insert Fields 
group, click either Address Block or Greeting Line to insert 

special merge fields. These merge fields combine data from several 
columns of the recipient’s record. When you insert one of these fields, 
Word displays a dialog box in which you can select options for the 
formatting of the output. If you use either of these merge fields, be 
sure to preview the results for every recipient and correct any unex-
pected output.

CAUTION  If the style applied to the merge fields includes 
paragraph formatting with extra space before or after the 

paragraphs, the lines might be spaced too widely. This particularly 
affects label and envelope merges, in which addresses with more than 
three or four lines might not fit. If necessary, apply another style such 
as No Spacing to the main document.
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Modify the merge with rules
1	 Insert a SET field if you want to store an unchanging number or text 

that can be used to perform comparisons or calculations for all of 
the recipients in a merge. On the Mailings tab, in the Write & Insert 
Fields group, click Rules and then, on the list that appears, click Set 
Bookmark. Continue at step 2.

2	 In the Insert Word Field: Set dialog box, type a bookmark name in 
the Bookmark list box, type the number or text in the Value text 
box, and then click OK.

The bookmark is located inside the SET field, which doesn’t display 
any result in the document. However, the bookmark can be refer-
enced in other fields elsewhere in the document, such as a REF field 
that will display the value, or a formula field that will use the value 
in a calculation.

3	 Insert an ASK field if you want to store a number or text that might 
be different for each recipient. On the Mailings tab, in the Write & 
Insert Fields group, click Rules and then, on the list that appears, 
click Ask. Continue at step 4.

Adding information with rules
The entries in the Insert Merge Field gallery represent only the 
columns that are present in the data source. In addition, you 
can use the fields in Word 2013 to perform comparisons and 

calculations during a mail merge, so you can display additional 
information, depending on the data in the data source.

1

2

3
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4	 In the Insert Word Field: Ask dialog box, type a bookmark name 
in the Bookmark box, type a question in the Prompt box, type a 
default value if desired, and then click OK.

During the merge, the prompt will be displayed for each recipient, 
and the value you enter will overwrite any previous value in the 
bookmark. If you want to use the same value for all of the recipients 
during the current merge, select the Ask Once check box.

The bookmark is located inside the ASK field, which doesn’t display 
any result in the document. However, the bookmark can be refer-
enced in other fields elsewhere in the document, such as a REF field 
that will display the value, or a formula field that will use the value 
in a calculation.

5	 If you want to display a number or text that might be different 
for each recipient, insert a FILLIN field. On the Mailings tab, in the 
Write & Insert Fields group, click Rules and then, on the list that 
appears, click Fill-in. Continue at step 6.

6	 In the Insert Word Field: Fill-in dialog box, type a question in the 
Prompt text box, type a default value if desired, and then click OK.

The FILLIN field is similar to the ASK field, except that the FILLIN 
field displays its value in the document and doesn’t store its value in 
a bookmark.

7	 Insert an IF…THEN…ELSE field where you need to display different 
results in the document, depending on the value of a merge field 
or other field. If you want to base the decision on a bookmark value 
(such as one in a SET field or an ASK field), continue at step 9.

On the Mailings tab, in the Write & Insert Fields group, click Rules 
and then, on the list that appears, click If…Then…Else. Continue at 
step 8.

4

5 6
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8	 In the Insert Word Field: If dialog box, select a merge field in the 
Field Name list box, select a condition in the Comparison box 
and, if necessary, enter a value in the Compare To list box. In the 
Insert This Text box, enter the result that the field will display if the 
comparison is true. In the Otherwise Insert This Text box, enter the 
result that the field will display if the comparison is false. Click OK.

9	 If you want to base the decision on a bookmark value (such as one 
in a SET field or an ASK field), click the Insert tab. In the Text group, 
click Quick Parts and then click Field. Continue at step 10.

10	In the Field dialog box, in the Field Name list box, click If. Then, click 
the Options button.

In the Field Options dialog, click the desired bookmark name and 
then click Add To Field. Click at the end of the expression in the 
Field Codes box and type the rest of the code.

For example, suppose the selected bookmark is Quantity, and you 
want the result to display copy if Quantity is 1 or copies if Quantity 
is greater than 1. The completed code for this field is IF Quantity = 
1 “copy” “copies”.

Click OK in the Field Options dialog box and then click OK in the 
Field dialog box.

8

10 9
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Merge to special outputs
1	 On the Mailings tab, in the Preview Results group, click Preview 

Results. If you selected a label merge, the preview shows the 
pages of labels. For any other kind of merge, the preview shows 
the output for only one recipient at a time. You can use the arrow 
buttons in the Preview Results group to display previews of the rest 
of the output.

If unwanted information appears in any of the previews or infor-
mation is missing, click Preview Results to turn it off. Then, edit the 
main document or the records in the data source to correct the 
problem and repeat the preview.

Finishing the merge
When the main document contains all of the merge fields, other 
fields, text, and graphics needed to prepare the output, it’s time 
to perform the final steps. Because of the length and complexity 
of the setup, you should first examine a preview to ensure that 

everything is in place. When you’re confident of the correct-
ness of the document and the sorting and filtering of the data 
source, you can run the final merge.

TIP  If you preview a label merge and only the first recipient’s 
label appears, you have skipped the step of clicking the Update 

Labels button (step 4 in “Insert merge fields in the document” on page 
342).

1
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2	 On the Mailings tab, in the Finish group, click Finish & Merge and 
then, in the list that appears, click one of the following:

•	 Edit Individual Documents  Merges the data from the data 
source into the merge fields to create a new document. You can 
edit this document, save it for later use, or print it like any other 
document.

•	 Print Documents  Merges the data from the data source into 
the merge fields and sends the result to the printer. The Print 
dialog box appears so that you can set the printer properties, 
the number of copies, and other options. Click OK to print.

•	 Send Email Messages  Merges the data from the data source 
into the merge fields and sends the result to the default email 
program. The Merge To Email dialog box appears so that you 
can enter the subject line and select the merge field that con-
tains the email address. Click OK to send.

3	 When the merge runs successfully, save the main document so that 
it can be used again.

2

3

SEE ALSO  For more information about mail merges, see www.
gmayor.com/merge_labels_with_word_2007.htm. The descriptions 

presented there also apply to Word 2013.
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Reviewing 
documents

When you prepare a document with input from many coworkers, 
you might use any of several methods. In one style, each person 

works alone on one or a few sections. Then somebody puts all the pieces 
together, smooths out differences in formatting and writing style, and 
publishes the result. Another method involves writing a draft, passing it 
around for review and comments, and editing the document to resolve 
any questions.

The Comments and Track Changes features provided by Microsoft Word 
2013 are ideal for multiple rounds of reviews, and the new Simple Markup 
view makes even heavily revised documents more readable.

In another scenario, perhaps your workflow results in several copies of the 
same document from different reviewers, with or without change tracking. 
The Compare and Combine features can pull together those multiple ver-
sions into a single document so that you can see all the changes at once. 

In this section:

■■ Adding comments

■■ Showing and hiding comments

■■ Tracking changes

■■ Showing and hiding tracked changes

■■ Setting options for tracked changes

■■ Accepting and rejecting changes

■■ Comparing reviewed versions

■■ Merging reviewed versions

13



Insert a comment
1	 On the Review tab, in the Comments group, click New Comment.

2	 Type your comment under your name in the Comments balloon.

Adding comments
If you send your document out for review, you or the other 
Word users can insert comments that don’t become part of the 
text. In Word 2013, you can also reply to a comment as you 
might in an email conversation. When you’ve settled the issue 

raised by a comment, you can delete the comment or you can 
mark the comment as completed. The completed comment 
and its replies remain in the document as a record of the issue’s 
resolution.

1 2

TRY THIS  If your Office 2013 installation includes Microsoft 
OneNote, you can type notes in OneNote about your Word 

document. OneNote automatically links the note to the current 
location your document. To make a note in OneNote, select the Review 
tab in Word and click Linked Notes.

TIP  If you use a tablet or a drawing pad, you can click Ink 
Comment and handwrite or draw your comment.

TIP  To remove a comment, click it, and then on the Review 
tab, in the Comments group, click Delete.
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Reply to a comment
1	 Click the reply icon at the right side of the Comment balloon.

2	 Type your reply in the Comment balloon under your name.

3	 To mark a comment as completed, right-click the Comment balloon 
and click Mark Comment Done.

TRY THIS  When you’re reviewing your own documents, you 
might want to show some of your comments with a different 

color as a way of separating comments into categories. You can do this 
by slightly changing your user name in Word. On the Review tab, in the 
lower-right corner of the Tracking group, click the dialog box launcher 
(the small arrow). In the Track Changes Options dialog box, click 
Change User Name. In the User Name box, add a digit or other text to 
your user name. Select the Always Use These Values Regardless Of Sign 
In To Office check box and then click OK. Add a new comment or reply 
to an existing comment. (Don’t forget to change back to your real user 
name after adding your comments.)

1

2

3
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Showing and hiding comments
When you’re reading and responding to comments, you’ll want 
to see all of them. When you’re reading the document for other 
purposes, though, the lines and balloons can be distracting. 

Word 2013 has a new Simple Markup view that hides the clutter 
and shows just an icon in the margin to indicate the presence of 
a comment.

View all markup
1	 On the Review tab, at the top of the Tracking group, click the drop-

down list and select All Markup, if it isn’t already selected.

TIP  To control what items are shown in balloons, on the 
Review tab, in the Tracking group, click Show Markup, point to 

Balloons, and then choose a setting from the menu.

TIP  When All Markup is selected, the comments appear in 
Outline or Draft view as tags in the text. You can position the 

cursor on a tag to see the comment or, on the Review tab, click 
Reviewing Pane.

1

1View simple markup
1	 On the Review tab, at the top of the Tracking group, click the drop-

down list and select Simple Markup, if it isn’t already selected. Click 
any Comment balloon to see its complete comment.
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Tracking changes
Whether you work on a document alone or with others, it’s 
often important to keep a record of what’s been changed, who 

made the changes, and when the changes were made. In Word 
2013, the Track Changes feature handles those details.

Turn on Track Changes
1	 On the Review tab, in the Tracking group, click Track Changes, if it 

isn’t already selected.

2	 Click the drop-down list at the top of the Tracking group and select 
All Markup, if it isn’t already selected.

3	 Edit or reformat the text.

1 2

3

SEE ALSO  For information about how to show the Track 
Changes indicator on the status bar, see “Customizing the 

screen” on page 414.

CAUTION  The built-in keyboard shortcut to switch Track 
Changes on and off is Ctrl+Shift+E. If you suddenly start seeing 

red text in a document while you’re editing, you might have pressed 
that combination by mistake.

TIP  In Outline or Draft view, you can position the cursor on a 
change to see its information or, on the Review tab, click 

Reviewing Pane.

Tracking changes: Turn on Track Changes  353

13: Reviewing documents



Showing and hiding tracked changes
When you’re revising a document, you’ll want to show the 
details for tracked changes to decide which ones to keep or 
reject. Conversely, when you just want to read a document 
without distraction, you can use the new Simple Markup view to 
hide the lines and balloons, leaving just an unobtrusive change 
bar in the margin.

Whichever markup view you select, you can list all the changes 
and comments in the Reviewing Pane. Double-clicking an entry 
in that pane moves the cursor to the location in the document 
so that you can navigate quickly through the changes.

View all markup or simple markup
1	 On the Review tab, at the top of the Tracking group, click the drop-

down list and select All Markup, if it isn’t already selected.

2	 At the top of the Tracking group, click the drop-down list and select 
Simple Markup. Click any change bar to return to All Markup view.

1

2

CAUTION  When tracked changes and comments are hidden, 
they’re still stored in the document and can be seen by anyone 

who receives a copy of the document. In some cases, that can be 
extremely embarrassing! Before you send out final copies of your 
document, use the procedures in “Accepting and rejecting changes” on 
page 358 to remove all changes and comments.

TIP  When many reviewers have added changes to the 
document, you can show the changes from only one or a 

selected few of them. On the Review tab, in the Tracking group, click 
Show Markup, point to Specific People, and then clear the check boxes 
next to the names of reviewers whose changes you want to hide.
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Display the Reviewing pane
1	 On the Review tab, in the Tracking group, click Reviewing Pane.

2	 Double-click an item in the Revisions list.

2 1

TRY THIS  Click the arrow next to Reviewing Pane to open the 
drop-down list and choose Reviewing Pane Horizontal. You can 

also drag the edges of the pane to resize it, or drag the pane’s title to 
make the pane “float” over the document.
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Setting options for Track Changes
The Track Changes feature works well with the default settings, 
but it also offers a lot of flexibility for different ways of work-
ing with reviewed documents. You can turn on tracking in your 

document and lock it so that the reviewers are required to 
record all of their changes. You can determine how changes and 
comments are displayed, and easily change those settings at will.

Lock tracking
1	 On the Review tab, in the Tracking group, click the bottom half of 

Track Changes and click Lock Tracking.

The Lock Tracking dialog box opens.

2	 Enter a password in the top text box. Enter the password again in 
the second box.

If you don’t want to protect Lock Tracking with a password, leave 
both boxes blank.

3	 Click OK.

3

2

1

1 3 2Set common options and advanced options
1	 On the Review tab, in the lower-right corner of the Tracking group, 

click the dialog box launcher.

The Track Changes Options dialog box opens.

2	 Select or clear the check boxes for the kinds of changes that you 
want to display.

3	 Click Advanced Options to change other settings, or click OK to 
return to the document.

TIP  Most of the items in the Track Changes Options dialog 
box also appear on the Show Markup menu. The Advanced 

Options, however, are accessible only through the dialog box.

356  Setting options for Track Changes: Lock tracking
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4	 In the Markup section of the Advanced Track Changes Options 
dialog box, select the color and formatting you want to use for 
insertions and deletions, the location of the change lines, and the 
color of the shading applied to commented text.

You can choose the same color for all reviewers, or you can let 
Word choose a different color for each reviewer.

5	 In the Moves, Table Cell Highlighting, and Formatting sections, 
choose the way you want those types of changes to appear. If you 
prefer not to track Moves and Formatting at all, clear their check 
boxes.

6	 In the Balloons section, set the width of the column in which bal-
loons are shown, the margin at which you want balloons to appear, 
and whether you want a line leading from each balloon to its corre-
sponding change in the document.

For a document in portrait orientation, you can instruct Word 
to print in landscape orientation to avoid compressing the text 
column.

7	 Click OK.

TIP  Whether you set a specific color for changes by all 
reviewers or select By Author, that setting applies only on your 

computer. Other reviewers who open the document will see colors 
according to their settings. You can’t be sure that a particular color will 
be assigned to a specific reviewer on other computers.

4

5

6

7
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Accepting and rejecting changes
If a document contains tracked changes, all the information 
about each change will stay in the document until you accept 
or reject the change. Setting the markup view or the options 
so that you can’t see the changes only hides them—it doesn’t 
remove them. Anyone else who opens the document can easily 
show the changes again. That isn’t necessarily a good thing.

For example, you might not want a client to see that you copied 
part of a report for another client and just changed the names. 
To protect yourself against such possibly embarrassing situa-
tions, you must review the changes and accept or reject them 
before you send your documents to others.

Accept or reject changes
1	 Open a document that has been reviewed. If it’s a Read-Only docu-

ment, save it with a different name or in a different folder.

2	 On the Review tab, in the Tracking group, ensure that Track 
Changes is not selected. If it is selected, click Track Changes to turn 
it off.

3	 At the top of the Tracking group, click the drop-down list and select 
All Markup, if it isn’t already selected.

4	 Click Next or Previous in the Changes group to locate a change, 
or click a change in the text or in a balloon. Select Accept to make 
the change permanent, or Reject to remove the change. Continue 
clicking Accept or Reject until you’ve handled all the changes in the 
document.

5	 Instead of working through the changes one at a time, you can click 
the bottom half of Accept or Reject and choose one of the other 
actions from the menu.

The Accept All Changes and Reject All Changes actions affect all the 
changes in the document at once. If you first use the Show Markup 
menu to hide some types of changes, the Accept All Changes 
Shown and Reject All Changes Shown actions affect only the 
changes that haven’t been hidden.

1 2 3

SEE ALSO  For information about comparing two versions of 
the same document and marking the differences between them, 

see “Comparing reviewed versions” on page 359.

SEE ALSO  For information about ensuring that the document 
doesn’t contain any revisions or comments, see “Using the 

Document Inspector” on page 392.

4

5
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Comparing reviewed versions
If you receive a reviewed copy of your document but the 
reviewer didn’t have Track Changes turned on, you can have 

Word 2013 mark the changes for you. All you need is the origi-
nal document, the reviewed copy, and the Compare feature.

Set up a comparison
1	 On the Review tab, in the Compare group, click Compare and 

choose Compare in the gallery.

The Compare Documents dialog box opens in its collapsed view.

2	 Specify the original document by clicking the down-arrow and 
selecting it from the list of recently used documents, or you can 
select the folder icon to browse for another file. In the same way, 
specify the revised document.

3	 If both versions of the document contain markup from the same 
reviewer, you can keep the two sets separated by entering a differ-
ent name or other text in the Label Changes With text box.

4	 If the dialog box is not expanded, click More.

5	 Leave the check boxes selected in the Comparison settings section 
for only the types of changes that you want to have marked in the 
result of the comparison.

6	 Choose whether the comparison will be made character by charac-
ter or word by word. Also choose where the changes will be shown. 
You can choose for the changes to appear in one or the other of the 
documents being compared, or in a new third document.

7	 Click OK.

1

24 3

7

5

6
TIP  You can use the Compare feature to create “legal 
blacklining” in contracts; this way, each party can see what 

revisions were made.
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View the results of comparing documents
1	 Examine the compared document (the one containing tracked 

changes) in the large pane. The two source documents are in 
smaller panes.

2	 On the Review tab, in the Tracking group, click Reviewing Pane to 
show or hide the pane.

3	 Save the compared document with the marked changes as a sepa-
rate file.

4	 Scroll through the compared document, accepting or rejecting the 
changes as you would for any document that has tracked changes. 
As you scroll the compared document, the source documents 
scroll to the same position so that you can see where the changes 
originated.

4

3

2 1

TIP  To hide one or both of the source documents, click 
Compare, point to Show Source Documents, and then select 

which source documents you want to see.

360  Comparing reviewed versions: View the results of comparing documents
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Merging reviewed versions
If you’ve sent your document to several reviewers who edited it 
separately, but with Track Changes turned on, you can use the 
Combine feature to merge the versions into one document with 

marked changes. You can then use the merged document to 
prepare a final version.

Merge reviews
1	 On the Review tab, in the Compare group, click Compare and 

choose Combine in the gallery.

2	 Specify the first document containing review changes by clicking 
the down-arrow and selecting from the list of recently used docu-
ments, or you can select the folder icon to browse for another file. 
In the same way, specify the second document containing changes.

3	 In each Label Unmarked Changes With text box, type a name or 
other text to identify the source of the changes in the correspond-
ing version of the document.

4	 If the dialog box isn’t expanded, click More.

5	 Leave the check boxes selected in the Comparison settings section 
for only the types of changes that you want to have marked in the 
result of the combination.

6	 Choose whether the combination will be made character by charac-
ter or word by word. Also, choose where the changes will be shown. 
You can choose for the changes to appear in one or the other of the 
documents being combined, or in a new third document.

7	 Click OK and save the combined document.

1

4 2

3

TIP  When you combine documents, the result can contain 
formatting changes from only one of them. If Word detects 

formatting changes in either source document, a dialog box gives you 
a choice of which set of formatting changes to keep in the result.

TIP  You can combine only two documents at a time. If you 
have several reviewed versions to combine, first combine two of 

them and then combine the result with a third reviewed version, and 
so on.
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Symbols
* (asterisk), wildcard searches,  57
@ (at sign), wildcard searches,  57
? (question mark), wildcard searches,  57

A
accepting document changes,  358
accounts, blog,  375
activating apps,  410
adding

commands to the toolbar,  16
comments,  350
common misspellings to AutoCorrect,  72
rows and columns,  187
words to custom dictionaries,  69

addresses
adding to envelopes,  316
formatting on envelopes,  323

aligning
floating objects,  282
pictures and text,  283

alignment
cells,  192
guides,  282, 283
paragraphs,  107
tables,  189

anchor, for picture,  283
applying set styles,  177
apps

from the Office Store,  406
using in documents,  410

art borders,  153

artistic effects in pictures,  295
asterisk (*), wildcard searches,  57
at sign (@), wildcard searches,  57
attachments, email,  332
AutoCorrect

adding common misspellings,  72
using AutoCorrect entries as shortcuts,  74

AutoFormat
manual AutoFormat,  78
setting options for,  76

AutoRecover,  28
AutoText,  63

B
background for Office,  428
backgrounds, removing from pictures,  293
Backstage view

about,  20
printing,  34
templates,  41

bibliographies,  264
Block Authors command,  373
blogging,  375
blue squiggles

formatting,  69
grammar,  68

bold, applying,  19
booklets, printing,  34
bookmarks

mail merge,  343
using,  211

borders
applying around a page,  151
dragging row and column borders,  188
styles,  116

Borders and Shading dialog box,  118
breaks (line and page),  113
Building Block Gallery content control,  218
building blocks

creating,  62
inserting,  61
organizing,  64

built-in footers,  138
built-in headers,  138
built-in page numbers,  138
built-in themes,  173
built-in watermarks,  237
bulleted list styles,  120
business cards,  326
business documents,  2

C
captions, inserting,  262
categories for blog posts,  377
cells

alignment and direction,  192
merging and splitting,  191
setting tab stops in,  186

center-align shortcut,  19
changes

accepting and rejecting document 
changes,  358

tracking,  353
viewing changes made by coauthors,  373

Index
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D
data, changing in diagrams,  310
date fields

formatting,  208
inserting using shortcuts,  210

Date Picker content control,  218
defaults

AutoCorrect,  72
headers and footers,  228
spacing in Normal style,  110
views,  17

definitions, obtaining,  79
deleting rows and columns,  187
deselecting,  42
diagrams, SmartArt,  308
dialog boxes

creating new styles with,  99
modifying styles with,  95

dictionaries
adding a word to custom dictionary,  69
custom,  432
definitions,  79

digital signatures
adding,  403
trusted locations and publishers,  387

discontinuous selection with Ctrl key,  42
display

customizing,  414
options,  429, 439
resolution,  6

Document Inspector,  392
documents

accepting and rejecting changes,  358
adding comments to,  350
adding envelopes to,  320
apps,  410
basing on a custom template,  168
closing,  19

commands
adding and removing from the toolbar,  16
assigning keyboard shortcuts to,  417
shortcuts for undo and redo,  19

comments
adding,  350
replying to,  351
showing and hiding,  352

comparing reviewed document versions,  359
configuration, AutoRecover,  28
content controls

grouping for a form,  222
inserting,  217
inserting document property content 

controls,  223
contextual errors,  68
contextual tab, objects,  14
converting text to a table and back 

again,  184
copying

Excel tables into Word,  183
formatting to another location,  106
items,  45
selections,  19
windows,  280

counting words,  82
cover pages, inserting,  154
cropping pictures,  286
cross-references,  216
Ctrl key (for discontinuous selection),  42
custom dictionaries, adding a word to,  69
custom templates, basing a new document 

on,  168
cutting

items,  45
selections,  19

changing
bulleted or numbered lists,  121
character formatting,  103
numbering values,  126

character formatting, changing,  103
character styles

applying from the Styles gallery,  93
defined,  90

characters
allowed in path file names,  24

charts, building,  304
Chart tool,  272
Check Box content control,  218
citation style,  264
clipboard

pasting contents,  19
using,  45

closing documents,  19
cloud computing

logging on to Office with Microsoft 
Account,  10

coauthors
communicating with,  374
working with,  372

collapsing headings,  59
color balance, pictures,  290
colors

font,  104
paragraph shading,  116
themes,  173, 174
transparent color in pictures,  296

columns
adding and deleting,  187
changing number of,  148
multicolumn,  148
resizing,  188

Combo Box content control,  218
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F
F8 key (Extend Mode),  43
Field dialog box,  200
fields

cross-reference fields,  216
Field dialog box,  200
formatting using switches,  205
inserting from the keyboard,  202
inserting page and date fields using 

shortcuts,  210
mail merge,  341
options,  438
StyleRef fields, inserting,  236
table of contents,  246
toggling field codes and updating,  203
XE fields,  255

figures, tables of,  262
File Block settings,  385
files

default file format,  434
default location,  435
locations,  441
path names,  24
Protected View,  383
SkyDrive,  370
trusted locations,  387

file types, exporting documents to,  26
filling shapes,  300
final documents,  400
Find dialog,  52
finding

templates,  159
using wildcards,  56

Flickr, inserting pictures from,  277
folders, user templates,  157
fonts

character formats,  94
themes,  173, 174

E
editing

headers and footers,  139
options,  436
PDF documents,  22
security,  397
templates,  161
in Word Web App,  368

effects
themes,  174
WordArt,  312

email, sending documents,  332
Encarta Dictionary,  79
endnotes

adding,  241
formatting,  242

end points in shapes,  303
entries (index),  255
envelopes

address formatting,  323
printing multiple copies,  320
printing single envelopes,  316
size and print options,  318

even and odd headers and footers,  171
examples

creating new styles with,  98
modifying styles with,  94

Excel
copying table into Word,  183
data source for mail merge,  337

expanding
headings,  59
objects,  31

exporting documents to other file types,  26
expressions, wildcard

in find expressions,  56
in replace expressions,  58

Extend Mode, F8 key,  43

comparing reviewed versions,  359
digital signatures,  403
exporting to other file types,  26
getting information about,  23
headers,  228
linking to,  214
linking to locations within,  212
margins,  140
merging reviewed versions,  361
navigating,  50
opening,  19, 20, 29
passwords,  394
presenting online,  378
printing,  34
privacy settings,  391
properties,  223
read-only or final,  400
recovering,  28
saving,  19, 24
sending by email,  332
setting options for track changes,  356
sharing,  367, 370
showing and hiding

comments,  352
tracked changes,  354

starting
a new document,  40
Word with an existing document,  12

tracking changes,  353
Word Web App,  364

downloading
proofing packages,  87
templates,  159

dragging row and column borders,  188
drawing shapes,  298
Drop-Down List content control,  218
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hide and show codes,  203
hiding

comments,  352
ribbon,  15, 19
tracked changes,  354

highlighting,  105
hyperlinks

bookmarks,  211
cross-references,  216
inserting,  212

hyphenation
automatic,  113
preventing,  115

I
illustrations, about,  270
indents,  107
indexing

about,  255
multiple indexes,  258

Info page,  23
inserting

art borders,  153
bibliographies,  268
blank pages at the end of a section,  136
bookmarks,  211
building blocks,  61
built-in page numbers,  138
charts,  304
comments,  350
content controls,  217
cover pages,  154
cross-references,  216
diagrams,  308
document property content controls,  223

text entries in the AutoCorrect list,  74
WordArt,  313

forms, grouping content controls for,  222

G
galleries, selecting building blocks from,  61
General tab,  428
grammar

correcting,  68
options,  430
setting proofing language,  86
using the grammar pane,  70

grouping
content controls  for a form,  222
shapes,  302

groups
adding tools to,  426
creating on the ribbon,  423

H
header rows, repeating,  193
headers

changing,  228
extracting text for,  234
inserting,  138
odd and even,  171
portrait header on landscape pages,  145
unlinking,  232

headings
collapsing and expanding,  59
list of,  50
spanning across multiple columns,  149
table of contents,  243
using multilevel numbered headings,  128

Help system
about,  36
shortcut for,  19

footers
extracting text for,  234
inserting,  138
odd and even,  171
unlinking,  232

footnotes
adding,  241
formatting,  242

formatting
changing character formatting,  103
copying to another location,  106
default file format,  434
diagrams,  309
envelope addresses,  323
fields using switches,  205
footnotes and endnotes,  242
Format Painter,  106
highlighting,  105
replacing,  54
revealing existing formatting styles,  132
security,  397
setting AutoFormat options,  76
styles

about,  90
adding borders and shading,  116
bulleted or numbered lists,  120
changing character formatting,  103
changing line and paragraph 

spacing,  110
changing numbering values,  126
changing paragraph alignment and 

indents,  107
creating and modifying,  94
kinds of,  90, 91
line and page breaks,  113
using multilevel numbered 

headings,  128
table of contents,  249
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locations
default file locations,  435
files,  441
trusted,  387

Lock Tracking,  356
logon, to Office with Microsoft Account,  10
lost documents, recovering,  28

M
macros, recording,  444
mailing labels,  326
mail merge

adding fields,  341
finishing,  346
recipients,  337
rules,  343
starting,  334

main header, creating,  228
manual AutoFormat,  78
manual spell check,  70
margins

choosing,  140
mirror margins,  170

marking
document for a table of contents,  252
index entries,  255
text for no proofing,  88

markup, viewing,  352, 354
merging

cells,  191
reviewed document versions,  361

Microsoft Accounts
logging on to Office,  10
Office Store apps,  406
setting up,  6
SkyDrive,  370

Microsoft Excel 2013, charts,  304

K
keyboard

customizing,  417
inserting fields from,  202
recording macros,  444
selecting text,  43
shortcuts

about,  18
assigning to a command,  417
assigning to symbols,  420

keytips, using with keyboard shortcuts,  18

L
labels

mailing,  326
mail merge to,  335

landscape pages, portrait headers,  145
language

setting proofing language,  86
translations,  83

left-align, shortcut for,  19
line borders,  151
linebreaks,  113
line spacing, changing with styles,  110
linked styles,  90, 91
linking

a chain of text boxes,  198
to documents or webpages,  214
to Excel worksheets,  183
to locations within your  document,  212

lists
bulleted or numbered lists with styles,  120
Drop-Down List content control,  218
including unnumbered paragraphs in,  126
multilevel list styles,  128
sorting,  225

fields
from the keyboard,  202
using the Field dialog box,  200

group content controls,  222
headers and footers,  138
hyperlinks,  212
indexes,  257
odd and even headers and footers,  171
online video,  278
page and date fields using shortcuts,  210
pictures,  284

from online,  276
from SkyDrive or Flickr,  277
from your computer,  274

screenshots,  280
section breaks,  136
shapes,  298
StyleRef fields,  236
table captions,  262
table of contents,  245
table of tables or table of figures,  263
tables,  181
tab stops on the ruler,  180
text,  44
text boxes,  196
watermarks,  237
WordArt,  312

inspecting, documents,  392
installing, apps for Office,  408
Internet

finding help on,  37
security,  390

invitations, sending,  378
italics, applying,  19

J
justifying text,  107
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inserting cover pages,  154
numbers

built-in,  138
updating in the table of contents,  248

orientation of,  144
portrait headers on landscape pages,  145
positioning pictures on,  282
size of,  140

paragraphs
breaks,  113
changing alignment and indents,  107, 109
changing spacing with styles,  110
numbered lists,  126
shortcuts for left-, right- and 

center-align,  19
styles

applying from Styles gallery,  92
defined,  90

paragraph styles
applying from the Styles gallery,  92
defined,  90

passwords, documents,  394
pasting

a table from Excel,  183
clipboard contents,  19
items,  46
from Office clipboard,  48
using Paste Special,  45, 46

PDF documents
editing,  22
saving,  26
using,  11

pictures
aligning,  283
blog posts,  376
changing the appearance of,  290
content control,  218
cropping,  286

Office Background,  428
Office clipboard,  48
Office.com, templates,  159
Office Store, apps,  406
OFFLINE,  36
online

accounts,  32
pictures, inserting,  276
presentation of documents,  378
video, inserting,  278

opening
documents,  19, 20
in Word Web App,  364
options for,  440
unsaved documents,  29
Word Web App in Word,  369

options
Advanced page,  436
Display tab,  429
General tab,  428
spelling and grammar,  430

Organizer, Building Blocks,  64
orientation of pages,  144
outline of shapes,  300
Outline view

about,  17
organizing topics,  60

overtyping
switching between insert and 

overtyping,  44
text,  44

P
pages

applying borders around,  151
fields, inserting using shortcuts,  210
inserting blank pages at the end of a 

section,  136

Microsoft Office
logging on with Microsoft Account,  10
Office clipboard,  48

Microsoft PowerPoint 2013, charts,  304
Microsoft SharePoint Workspace,  370
minimize, ribbon,  415
Mini Translator,  85
mirror margins,  170
modifying, styles,  94
mouse, selecting text,  42

N
names, preparing a list of for sorting,  225
Navigation pane

about,  50
organizing topics,  60
search feature,  51

Normal.dotm, starting a new document,  40
Normal style

default spacing,  110
shortcut for applying,  19

Normal template, using,  156
numbers

built-in page numbers,  138
changing values,  126
headings, using multilevel numbered 

headings,  128
numbered lists, styles,  120
Numbering Library,  125

numeric fields, formatting,  207
numeric picture switch,  205

O
objects

contextual tab,  14
expanding,  31

odd and even headers and footers,  171
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using wildcards,  56
wildcards in replace expressions,  58

replying, to a comment,  351
resizing, rows and columns,  188
resolution, display,  6
restoring, using the Undo list,  49
revealing, existing formating,  132
reviewing

document versions and comparing,  359
merging reviewed document versions,  361

ribbon
about,  14
adding a ribbon item to the Quick Access 

Toolbar,  421
buttons

adding borders and shading with,  116
formatting text with,  103

changing paragraph alignment and 
indents,  107

hiding or showing,  19, 415
resizing pictures,  285
tabs and groups,  423

Rich Text content control,  218
right-align, shortcut for,  19
rotating

pictures,  284
text in table cells,  192

rows
adding and deleting,  187
repeating header rows,  193
resizing,  188

ruler
changing paragraph alignment and 

indents,  107
tab stops,  180

rules, mail merge,  343

proofing, changing the proofing language of 
text,  86

properties
content controls,  220
documents,  23, 223

Protected View,  383
publishers, trusted,  387

Q
question mark (?), wildcard searches,  57
Quick Access Toolbar,  16

customizing,  421
Quick Style gallery,  442
Quick Tables building block gallery,  181

R
Reading view of Word Web App,  364
Read Mode

about,  10
optimization of,  17
using,  30

read-only documents,  400
recoloring, pictures,  292
recording, macros,  444
recovering, documents,  28
redo, shortcut for,  19
red squiggles,  68
rejecting, document changes,  358
removing

backgrounds from pictures,  293
commands from the toolbar,  16
unwanted parts of pictures,  286

repeating, header rows,  193
Repeating Section content control,  218
replacing

formatting,  54
pictures,  288
text,  54

inserting
from online,  276
from SkyDrive or Flickr,  277
from your computer,  274

options,  437
positioning on page,  282
recoloring,  292
removing backgrounds,  293
replacing,  288
resizing,  284
special effects,  293, 295
transparent color,  296
watermarks,  239

placeholders
bibliographies,  266
text, content controls,  219

Plain Text content control,  218
portrait headers, landscape pages,  145
positioning, pictures on the page,  282
posting

blog entries,  377
invitations,  378

presentations,  379
printing

business cards,  328
documents,  34
envelopes,  322
labels,  326, 331
multiple copies of an envelope,  320
options,  439
shortcut for,  19
single envelopes,  316
templates for two-sided printing,  170

Print Layout view
about,  10, 17
using,  17
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spelling
adding common misspellings to 

AutoCorrect,  72
correcting,  68
manual spell check,  70
marking text to ignore spelling,  71
options,  430
setting proofing language,  86
using AutoCorrect entries as shortcuts,  74

splitting, cells,  191
squiggles underlining text,  68
starting the Word program,  12
status bar

show or hide items,  414
word count,  82

Style Inspector,  133
StyleRef fields

headers and footers,  234
inserting,  236

styles
about,  90
adding borders and shading,  116
bulleted or numbered lists,  120
changing

character formatting,  103
line and paragraph spacing,  110
numbering values,  126
paragraph alignment and indents,  107

citations,  264
creating and modifying,  94
custom styles,  234
envelope addresses,  324
gallery

applying character styles,  93
applying paragraph styles,  92

mail merge,  323
options,  442
revealing existing formatting,  132

shapes
changing appearance of,  300
cropping to,  287
gallery,  271
inserting,  298

SharePoint server
opening documents from,  20
SkyDrive,  370

sharing
using SkyDrive,  370
with Word Web App,  367

shortcuts
assigning,  417
inserting page and date fields using,  210
obtaining synonyms,  80
starting Word,  12
using AutoCorrect entries as shortcuts,  74

show and hide codes,  203
Show/Hide button, revealing formatting,  132
showing

comments,  352
ribbon,  19
tracked changes,  354

Simple Markup view
showing and hiding comments,  352
tracked changes,  10

SkyDrive
inserting pictures from,  277
opening documents from,  20
sharing,  370

SmartArt,  272
creating diagrams,  308

social networking, with SkyDrive,  371
sources, bibliographies,  265, 266
spacing, changing line and paragraph 

spacing,  110
special effects, pictures,  295

S
saving

building blocks,  62
documents,  19, 24
options for,  440
templates,  163

screen, customizing,  414
screenshots

inserting,  280
using,  271

ScreenTip Style list box,  428
search, Navigation Pane,  51
sections

breaks, inserting,  136
headers,  228
inserting blank pages at the end of,  136

security
digital signatures,  403
Document Inspector,  392
document passwords,  394
editing and formatting,  397
marking documents read-only or 

final,  400
privacy settings,  390
Trust Center,  382
trusted locations and trusted 

publishers,  387
selecting

objects behind text,  283
text,  42
text that has the same style,  102

selections
copying,  19
cutting,  19

shading
Borders and Shading dialog box,  118
styles,  116
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text wrapping
charts,  306
pictures,  282
tables,  190

themes
using,  173
using table styles for uniform 

appearance,  194
thesaurus, synonyms,  81
thumbnails, Navigation Pane,  50
toggling, field codes,  203
tools, adding to groups,  426
topics, organizing,  59
touchscreens,  7
tracking changes

setting options for track changes,  356
showing and hiding tracked changes,  354
Simple Markup view,  10
turning on track changes,  353

translations,  83
transparent color, pictures,  296
Trust Center,  382
trusted locations and trusted publishers,  387
two-sided printing, templates,  170

U
underline, applying,  19
undo

shortcut for,  19
using,  49

unlinking, headers and footers,  232
unsaved documents, recovering,  29
updating

fields,  203
table of contents,  248

user name and initials,  428
user templates folder,  157

using table styles for uniform 
appearance,  194

table styles,  90, 91, 194
templates

basing a new document on a custom 
template,  168

blog posts,  375
customizing,  161
designing,  165
finding and downloading,  159
labels,  326
modifying and saving,  163
Normal template,  156
saving changes,  64
security,  397
starting documents with,  40
two-sided printing,  170
user templates folder,  157

text
adding to shapes,  302
aligning,  283
converting to a table and back again,  184
direction in cells,  192
entering text in a new blank document,  40
extracting for headers and footers,  234
fields, formatting,  209
headers and footers,  228
inserting and overtyping,  44
marking

to ignore spelling,  71, 88
replacing,  54
selecting,  42
sorting selected list text,  226
translations of selected text,  84
watermarks,  238

text boxes
as a shape object,  298
inserting,  196
linking a chain of text boxes,  198

security,  397
style sets, using,  173
Styles pane,  100
table of contents,  249
using multilevel numbered headings,  128
using table styles for uniform 

appearance,  194
switches, formatting fields using,  205
switching, views,  17
symbols, assigning keyboard shortcuts 

to,  420
synonyms, obtaining,  79

T
tab stops

creating on the ribbon,  423
inserting on the ruler,  180
table cells,  186

table of contents
generating,  243
multiple table of contents,  252
styles,  249
updating,  248

tables
adding and deleting rows and 

columns,  187
alignment,  189
cell alignment and direction,  192
converting text to a table and back 

again,  184
copying an Excel table into Word,  183
inserting,  181
merging and splitting cells,  191
repeating header rows,  193
resizing rows and columns,  188
setting tab stops in table cells,  186
tables of tables and tables of figures,  262
text wrapping,  190
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X
XPS (XML Paper Specification), support 

for,  26

W
watermarks, inserting,  237
Web Layout view, about,  17
webpages, linking to,  214
what’s new,  10
white space, show or hide,  416
wildcards

find and replace,  56
replace expressions,  58

Windows 8, Word shortcut,  13
windows, copying,  280
WordArt, effects,  312
words, counting,  82
Word Web App,  11, 364
worksheets, links to Excel worksheets,  183
wrapping table text,  190

V
versions

comparing reviewed document 
versions,  359

exporting to earlier Word file formats,  26
merging reviewed document versions,  361
previous versions of Word

compatibility with Word 2012,  3, 21
saving new versions of documents,  25

video, inserting online video,  278
viewing markup,  352, 354
views, switching,  17
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What do you think
of this book? 
We want to hear from you! 

To participate in a brief online survey, please visit: 


Tell us how well this book meets your needs—what works effectively, and what we can do better.  

Your feedback will help us continually improve our books and learning resources for you.   


Thank you in advance for your input!
 

microsoft.com/learning/booksurvey 
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